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INTRODUCTION 
The ADuCRF101 is a fully integrated data acquisition solution 
designed for low power wireless applications. It features a 12-bit 
ADC, a low power Cortex™-M3 core from ARM, a 431 MHz  
to 464 MHz and 862 MHz to 928 MHz RF transceiver, and 
Flash/EE memory packaged in a 9 mm × 9 mm LFCSP. 

Refer to the ADuCRF101 product page for future updates. 

Additional support for the ADuCRF101 is available through  
the EngineerZone® website. 

GENERAL DESCRIPTION 
The ADuCRF101 development system allows evaluation of 
ADuCRF101 silicon. This getting started guide introduces the 
support features and tools supplied with the evaluation kit. In 
addition, it shows and describes how to connect the evaluation 
hardware and explains when external components are required 
for operation.  

This guide describes the software files that are included on the 
DVD and explains how to download them. This guide works as 
a tutorial by providing a step-by-step account of how to download 
evaluation versions of third-party software tools. Instructions 
are provided for how to load code examples that are supplied on 
the DVD. These examples demonstrate the simple operation of 
the ADuCRF101.  

Working through this guide brings the user to a stage where 
they can start to generate and download their own user code  
to use in their own unique end-system requirements. 

The radio interface engine (RIE) is the software programming 
interface that controls the ADuCRF101 radio. This interface 
allows users to easily configure and use the radio. 

The Analog Devices, Inc., ADRadioNet™ wireless networking 
solution is available on request. 

 

ADuCRF101 MINI BOARD AND EMULATOR BOARD 

 
Figure 1.  
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DEVELOPMENT SYSTEMS OVERVIEW 
Different systems are available that are optimized for the 
various types of evaluation requirements. 

Table 1 lists the contents available for each type of system. 

Table 1. Development Systems Content 

Content 
Mini Kit 
(MK) 

QuickStart 
(QS) 

QuickStart Plus 
(QSP) 

Mini Board 1 1 2 
Antenna 1 1 2 
Emulator Board 0 1 1 
Battery Holder 0 0 1 
DVD 1 1 1 
 

The mini board is optimized for 433 MHz or 868 MHz/915 MHz 
operation. Table 2 lists the models and their optimized communi-
cation frequency. 

Table 2. Development Systems Models 
Model Description Frequency 
EV-ADuCRF101MK1Z Mini kit 868 MHz/915 MHz 
EV-ADuCRF101MK3Z Mini kit 433 MHz 
EV-ADuCRF101QS1Z QuickStart 868 MHz/915 MHz 
EV-ADuCRF101QS3Z QuickStart 433 MHz 
EV-ADuCRF101QSP1Z QuickStart Plus 868 MHz/915 MHz 
EV-ADuCRF101QSP3Z QuickStart Plus 433 MHz 
 

This getting started guide assumes that a mini board and an 
emulator board are available. 

ADRadioNet WIRELESS NETWORKING 
ADRadioNet is a wireless networking solution for the ISM 
band. It uses IPv6 addresses and combines most of the features 
expected in such solutions, that is, low power, multi-hop, end-
to-end acknowledgement, self-healing, and so on. Even with all 
of these features, the main feature of ADRadioNet is ease of use. 

ASSEMBLING THE HARDWARE 
Do not plug in the hardware before the software is installed (see 
the Software Installation section). 

 

Figure 2. ADuCRF101 Mini Board and Emulator Board 

DVD CONTENTS 
Each kit contains a DVD with the following contents: 

 Documentation 
 Analog Devices utilities 
 Third-party software 
 Comprehensive example code 
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SOFTWARE INSTALLATION 
Each kit includes a DVD containing software to be installed on 
the PC before the evaluation board is used. 

WARNING 
The J-Link OB driver must be installed before plugging the 
emulator board USB device into the PC. 

SOFTWARE CONTENT PROVIDED 
Table 3 shows the tools provided on the DVD. 

Table 3. Tools  
Tools Functions 
Keil μVision® For compiling/debugging and code 

development, a 32 kB limited version 
IAR Embedded 
Workbench® 

For compiling/debugging and code 
development, a 32 kB limited version 

Segger J-Link 
Software 

J-Link software and documentation pack 
includes USB drivers for the emulator, J-Link 
Commander, and J-Mem 

CM3WSD A utility that accepts a hex file and allows it 
to be downloaded via the USB interface to 
the ADuCRF101 device on your evaluation 
board 

Elves An application that helps a C programmer 
choose appropriate functions from Analog 
Devices libraries and simplifies deciding 
which values to place in the function 
parameters 

There are three parts to the installation: 

 ADuCRF101 documentation and code example copy. 
 J-Link OB driver installation. 
 Integrated software development tool installation  

(Keil μVision or IAR Embedded Workbench for ARM 
(EWARM)). 

COPYING THE CONTENTS FROM THE DVD 
To copy documentation, code examples, and utilities, insert the 
DVD into the CD-ROM drive, and copy the ADuCRF101v1.0 
folder to the PC hard drive. 

All subsequent steps assume that this folder has been copied 
directly onto the C drive. 

CM3WSD.exe 

The folder \ADuCRF101V1.0\Software Tools\CM3WSD 
provides an executable called CM3WSD.exe. This software 
accepts a hex file and allows it to be downloaded via the USB 
interface to the ADuCRF101 device on your evaluation board.  

You may want to add a shortcut link for this executable to your 
desktop. 

Elves.exe 

The \ADuCRF101V1.0\Software Tools\Elves folder contains 
the elves.exe files. These files are useful tools that accompany 
the software function libraries in 
\ADuCRF101v1.0\Code\ADuCRF101\DasLib. Again, 
installation is not required, but you may want to add a shortcut 
link for this executable to your desktop. 
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INSTALLING THE J-LINK OB DRIVER 
The J-Link OB USB driver is required to be installed before 
using a serial wire interface, such as the interface of the IAR 
Embedded Workbench, to download and debug code. 

To install the J-Link OB USB driver,  

1. Double-click the Setup_JLinkARM_V470.exe executable 
file located in the Segger folder on the DVD.  

2. Follow the on-screen instructions to complete the 
installation. Ensure that the Install USB Driver for J-Link-
OB with CDC option is checked as shown in Figure 3. 

 
Figure 3. Segger Driver Install Options 

3. Plug in the emulator board and check the device manager 
(see Figure 4). 

4. Check that the emulator board appears in the Windows® 
Device Manager in both the communications port and the 
USB controllers lists. 

 
Figure 4. Device Manager 

CONCLUSION 
After following the software installation procedures, the USB driver 
for the J-Link OB is installed and verified. 

You can, therefore, proceed to developing code and down-
loading it to the ADuCRF101. 
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IAR INSTALLATION AND TOOLS 
IAR TOOLS INSTALLATION 
The IAR Embedded Workbench is required for building the 
supplied examples and for downloading and debugging 
applications via the serial wire interface. 

To install the IAR Embedded Workbench, double-click the 
EWARM-CD-6503.exe executable file located in the IAR folder 
on the DVD—this folder was not copied onto the hard drive 
during the software installation procedure.  

Note that installing the IAR Embedded Workbench requires an 
active Internet connection to register on the IAR website and to 
obtain a free license key.  

Follow the on-screen instructions to install the IAR Embedded 
Workbench.  

IAR DEMO CODE 
Several example projects are available in the IAR workspace 
located in the following directory: 

C:\ ADuCRF101v1.0\Code\Examples\ADUCRF101.eww 

To open this workspace, from the File menu, choose  
Open>Workspace…, and navigate to the workspace file.  

 
Figure 5. Opening the IAR Workspace 

Several relevant projects are available within this workspace as 
shown in Figure 6. 

 
Figure 6. Available Projects in the Workspace 

Each example includes a comprehensive low level peripheral 
function library called DasLib, which can be used to interface  
to the peripherals of the ADuCRF101. 

Comprehensive documentation for both the libraries and the 
examples are included as shown in Figure 7. 

ADuCRF101v1.0\Documentation\DasLib\index.html 

 
Figure 7. DasLib Library Set 
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Changing Projects 

To change projects, right-click on a different project in the 
workspace and click Set as Active from the menu that appears 
(see Figure 8). 

 
Figure 8. Changing Projects 

Modifying a Project 

To modify a project, 

1. Make a change to one of the source files contained in the 
project. 

2. Save the file. (The project then requires recompiling before 
downloading to the ADuCRF101.) 

3. Click make (see Figure 9) to recompile the project as 
shown in Figure 10. 

 
Figure 9. IAR Make Toolbar Button 

 
Figure 10. Recompiling Projects 

Downloading and Debugging a Project 

To download and debug a project,  

1. Click debug. (Debugging of the code execution starts at 
the beginning of the main function. The following debug 
features can be used: single step, step over, breakpoint.) 

 
Figure 11. IAR Debug Toolbar Button 

2. Click go as shown in Figure 12.  

 
Figure 12. IAR Go Toolbar Button 

The code then executes on the ADuCRF101.  
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USING THE RADIO EXAMPLE 
INTRODUCTION 
The following is required for use with the radio example project: 

 Two mini boards 
 Two emulator boards 
 Two antennas 
 Two USB cables 

The example workspace described in the IAR Demo Code section 
should still be opened within the IAR Embedded Workbench. 

The following two radio examples are provided in the example 
workspace:  

 Radio transmit (see Radio – Transmit in Figure 15) 
 Radio receive (see Radio – Receive in Figure 15) 

One mini board is used to demonstrate how to transmit a radio 
packet. The other mini board is used to receive the radio packet 
that was transmitted.  

These examples use the radio interface engine, which is the 
mechanism for accessing the radio on the ADuCRF101. 

The full documentation for the radio interface engine functions can 
be found in the following document in the Documentation folder:  

ADuCRF101RadioInterfaceEngineFunctions_Rev0_1326.pdf 

HARDWARE SETUP 
For the purpose of this example, designate one mini board as 
the transmitter and the other as the receiver. The hardware 
contained within these kits should be connected as shown in 
Figure 13. 

 
Figure 13. Radio Demo Hardware Setup 

Note the serial number of the emulator board connected to the 
transmitter and also of that connected to the receiver. The serial 
number of the emulator board is marked on the underside of 
the emulator board as shown in Figure 14. It will be needed  
to identify the transmitter and receiver to IAR EWARM in a 
later step. 

 
Figure 14. Emulator Board Serial Number 
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DOWNLOADING THE RADIO TRANSMIT EXAMPLE 
To download the radio transmit example to the mini board 
designated as the transmitter, 

1. Select the Radio – Transmit example program in the IAR 
Embedded Workspace as shown in Figure 15. 

 
Figure 15. Selecting the Radio Transmit Example Program 

2. Select Rebuild All from the Project menu, as shown in 
Figure 16. (Note that you should always perform a Rebuild 
All action after switching projects.) 

 
Figure 16. Rebuild the Project 

3. Download the project by selecting Download active 
application as shown in Figure 17. You will be prompted 
to select the correct emulator board as shown in Figure 18. 
Select the serial number of the emulator board that you 
designated previously as the transmitter. 

 
Figure 17. Download the Radio Transmit Example 
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Figure 18. Selecting the Transmitter Mini Board 

An example of a radio transmit program is shown in Figure 19. 

 
Figure 19. Transmit Example Program  

DOWNLOADING THE RADIO RECEIVE EXAMPLE 
To download the radio receive example to the mini board 
designated as the receiver, 

1. Select the Radio – Receive example program in IAR 
Embedded Workspace as shown in Figure 20. 

 
Figure 20. Selecting the Radio Receive Example Program 

2. Select Rebuild All from the Project menu as shown in 
Figure 16. (Note that you should always perform a Rebuild 
All action when switching projects.) 

3. Download the project by selecting Download active 
application as shown in Figure 17. You will be prompted 
to select the correct emulator board as shown in Figure 21. 
Select the serial number of the emulator board that you 
designated previously as the receiver. 

 
Figure 21. Selecting the Receiver Mini Board 
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An example of a radio receive program is shown in Figure 22. 

 
Figure 22. Receive Example Program 

RUNNNING THE EXAMPLE 
To run an example, 

1. Press the RESET switch on the mini board designated as 
the receiver to place the board in receive mode. (Observe 
that the LED on this board is not blinking.) 

2. Press the RESET switch on the mini board designated as 
the transmitter to transmit a single packet. 

3. The LED on the mini board designated as the receiver 
should begin blinking, indicating that a packet has been 
received. 

4. A terminal program, such as HyperTerminal, can be 
connected to the COM port of the receiver to get a visual 
indicator of the packet received. 

 
Figure 23. Receiver Terminal Program Output 
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APPENDIX A 
SOFTWARE DOCUMENTATION 
The documentation described in Table 4 is available on the DVD. Any user of the ADuCRF101 development systems should consult these 
documents before proceeding to explore the ADuCRF101. 

Table 4. Software Documentation Included on DVD 
Folder File Name Description 

Beta_ADuCRF101v1.0\Documentation\ ADuCRF101GetStarted_UG481.pdf  ADuCRF101 tutorial guide for use 
with the ADuCRF101 
development system 

Beta_ADuCRF101v1.0\Documentation\DasLib\ index.html DasLib low level function library 
reference 

Beta_ADuCRF101v1.0\Documentation\DataSheet\ ADuCRF101Datasheet.pdf ADuCRF101 Sp0 data sheet 
 ADuCRF101_UG_231.pdf ADuCRF101 user guide 

Beta_ADuCRF101v1.0\Documentation\Evaluation Board\ ADuCRF101_EvalBrdGuide_UG480.pdf ADuCRF101 Evaluation Board 
User Guide 

Beta_ADuCRF101v1.0\Documentation\RadioInterfaceEngine\ ADuCRF101RadioInterfaceEngineFunctions.pdf Describes the RIE functions 
implemented on the 
ADuCRF101 

Beta_ADuCRF101v1.0\Documentation\Technotes\ AN-772.pdf A Design and Manufacturing 
Guide for the Lead Frame Chip 
Scale Package (LFCSP) 

 AN-1159.pdf I2C-Compatible Interface on 
Cortex-M3 Based Precision 
Analog Microcontroller 
(ADuCxxx Family) 

 AN-1160.pdf Cortex-M3 Based ADuCxxx 
Serial Download Protocol 
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APPENDIX B 
IAR DOWNLOAD INITIAL SETUP AND TROUBLESHOOTING 
To set up the configuration for an IAR project, 

1. Right-click the project name in the workspace area or in the 
project pull-down menu to access the project configuration. 

2. Click General Options in the Category box, and select 
AnalogDevices ADUCRF101 as the device in the Target 
tab as shown in Figure 24. 

 
Figure 24. Selecting the Device 

3. Click C/C++ Compiler in the Category box, and specify 
the include directory as shown in Figure 25 in the 
Preprocessor tab. 

 
Figure 25. Specifying the Include Directory 

4. Click Linker in the Category box, and override the linker 
configuration file by selecting Override default in the 
Linker configuration file section of the Config tab as shown 
in Figure 26. 

 
Figure 26. Overriding the Linker Configuration File 

5. Click Debugger in the Category box, and select J-Link/ 
J-Trace from the Driver box and Run to main in the 
Setup tab as shown in Figure 27. 

 
Figure 27. Setting Up the Driver 
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6. Click Debugger in the Category box, select Verify 
download and Use flash loader(s) in the Download tab  
as shown in Figure 28.  

 
Figure 28. Setting the Debugger Download Options 

7. Click J-Link/J-Trace in the Category box, and configure 
the Setup tab as shown in Figure 29.  

 
Figure 29. Configuring the J-Link/J-Trace Settings 

8. With J-Link/J-Trace still selected in the Category box, 
configure the Connection tab as shown in Figure 30.  

 
Figure 30. Selecting the Connection Options 
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APPENDIX C 
WINDOWS SERIAL DOWNLOADER 
The Windows serial downloader for a Cortex-M3 based part 
(CM3WSD) is a Windows software program that allows a user 
to serially download Intel extended hex files as created by 
assembler/compilers to the ADuCRF101 via the serial port. The 
Intel extended hex file is downloaded into the on-chip Flash/EE 
program memory via a selected PC serial port.  

See the Installing the J-Link OB Driver section for information 
on how to determine the correct COM port to use on the PC. This 
COM port should be used in all subsequent steps. 

The emulator board USB driver should be installed as per the 
Installing the J-Link OB Driver section before proceeding. 

Preparing for Downloading 

Prepare the system for downloading by configuring the board 
as follows: 

1. Connect the ADuCRF101 mini board to the emulator board. 
2. Connect the interface board to the PC using a USB cable.  

 
Figure 31. ADuCRF101 Mini Board Connected to Emulator Board 

3. Place the ADuCRF101 into serial download mode using 
the following sequence: 
a. Hold down the BOOT switch on the mini board.  
b. Press and release the RESET switch on the mini board. 
c. Release the BOOT switch on the mini board. 

 
Figure 32. Boot and Reset Switches 

Downloading 

To begin a download, 

1. Launch the Windows serial downloader by double-clicking 
CM3WSD.exe in the following directory:  
C:\ADuCRF101v1.0\Software Tools\CM3WSD 

 
Figure 33. Downloading Using CM3WSD 

2. Select the following file:  
C:\ADuCRF101v1.0\Software Tools\CM3WSD\ 
sample.hex 
(The sample.hex file is a simple program that causes an 
LED to continuously blink, indicating the successful down-
load of code.) 

3. Select the correct JLINK CDC UART COM port from the 
Serial Port box. 

4. Select a baud rate of 115200 from the Baudrate box. 
5. Click Start in the CM3WSD dialog box. The CM3WSD 

sends a reset command to the ADuCRF101.  
a. If the ADuCRF101 is in serial download mode and the 

COM port between the PC and the mini board is set 
up correctly, the CM3WSD starts downloading 
the .hex file and display a progress bar.  

b. After the file is successfully downloaded, the Monitor 
Status box displays the message Flashing Complete. 

6. Click Reset in the CM3WSD dialog box to run the program. 
a. An LED begins blinking on the mini board indicating 

that the .hex file has been downloaded and is 
executing. 

b. The Monitor Status box displays the message Running. 
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APPENDIX D 
USING ELVES.EXE 
Elves is a useful tool for generating simple C function libraries 
to get started on evaluating any peripheral. All the user needs  
to do is choose the required parameters for each function  
and Elves generates the C source code that configures all the 
appropriate ADuCRF101 registers. 

1. In the folder, C:\ADuCRF101v1.0\Software 
Tools\Elves, double click the file Elves.exe to launch 
Elves. 

 
Figure 34. Launching Elves 

2. To add a library, click Add and go to the directory 
C:\ADuCRF101v1.0\Code\DasLib. 

A list of header files is available. Add the header file(s) that 
you wish to use.  

 
Figure 35. Select Source Library 

For example, if the AdcLib.h library is added (see  
Figure 35), the user can generate functions to control  
the ADC. 

 
Figure 36. List of Functions 

Take, for example, the function AdcCfg, in the Choose 
Function section as shown in Figure 36. The user 
configures the parameters to meet their needs and each 
parameter is explained in the Source Code section of the 
window shown in Figure 37.  

  
Figure 37. Selecting Parameters 

3. Once satisfied with the register settings, select Copy and 
then paste this function into your source code in Keil  
or IAR. 
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APPENDIX E 
SERIAL COMMUNICATION WITH THE PC 
Examples that use the UART can be communicated with using 
the following HyperTerminal setup: 

1. Open HyperTerminal or an equivalent serial 
communication tool.  

2. Select the COM port that corresponds with the USB 
emulator board.  

3. Configure this COM port as shown in Figure 38. 

 
Figure 38. COM Port Setup 
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RELATED LINKS 
Resource Description 
ADuCRF101 Product Page, ADuCRF101 Precision Analog Microcontroller ARM Cortex-M3 with ISM Band Transceiver  
AN-772 Application Note, A Design and Manufacturing Guide for the Lead Frame Chip Scale Package (LFCSP) 
AN-1160 Application Note, Cortex-M3 Based ADuCxxx Serial Download Protocol  
AN-1159 Application Note, I2C-Compatible Interface on Cortex-M3 Based Precision Analog Microcontroller (ADuCxxx Family) 
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ESD Caution  
ESD (electrostatic discharge) sensitive device. Charged devices and circuit boards can discharge without detection. Although this product features patented or proprietary protection 
circuitry, damage may occur on devices subjected to high energy ESD. Therefore, proper ESD precautions should be taken to avoid performance degradation or loss of functionality. 

Legal Terms and Conditions 
By using the evaluation board discussed herein (together with any tools, components documentation or support materials, the “Evaluation Board”), you are agreeing to be bound by the terms and conditions 
set forth below (“Agreement”) unless you have purchased the Evaluation Board, in which case the Analog Devices Standard Terms and Conditions of Sale shall govern. Do not use the Evaluation Board until you 
have read and agreed to the Agreement. Your use of the Evaluation Board shall signify your acceptance of the Agreement.  This Agreement is made by and between you (“Customer”) and Analog Devices, Inc. 
(“ADI”), with its principal place of business at One Technology Way, Norwood, MA 02062, USA. Subject to the terms and conditions of the Agreement, ADI hereby grants to Customer a free, limited, personal, 
temporary, non-exclusive, non-sublicensable, non-transferable license to use the Evaluation Board FOR EVALUATION PURPOSES ONLY. Customer understands and agrees that the Evaluation Board is provided 
for the sole and exclusive purpose referenced above, and agrees not to use the Evaluation Board for any other purpose. Furthermore, the license granted is expressly made subject to the following additional 
limitations: Customer shall not (i) rent, lease, display, sell, transfer, assign, sublicense, or distribute the Evaluation Board; and (ii) permit any Third Party to access the Evaluation Board. As used herein, the term 
“Third Party” includes any entity other than ADI, Customer, their employees, affiliates and in-house consultants. The Evaluation Board is NOT sold to Customer; all rights not expressly granted herein, including 
ownership of the Evaluation Board, are reserved by ADI. CONFIDENTIALITY. This Agreement and the Evaluation Board shall all be considered the confidential and proprietary information of ADI. Customer may 
not disclose or transfer any portion of the Evaluation Board to any other party for any reason. Upon discontinuation of use of the Evaluation Board or termination of this Agreement, Customer agrees to 
promptly return the Evaluation Board to ADI. ADDITIONAL RESTRICTIONS. Customer may not disassemble, decompile or reverse engineer chips on the Evaluation Board. Customer shall inform ADI of any 
occurred damages or any modifications or alterations it makes to the Evaluation Board, including but not limited to soldering or any other activity that affects the material content of the Evaluation Board. 
Modifications to the Evaluation Board must comply with applicable law, including but not limited to the RoHS Directive. TERMINATION. ADI may terminate this Agreement at any time upon giving written notice 
to Customer. Customer agrees to return to ADI the Evaluation Board at that time. LIMITATION OF LIABILITY. THE EVALUATION BOARD PROVIDED HEREUNDER IS PROVIDED “AS IS” AND ADI MAKES NO 
WARRANTIES OR REPRESENTATIONS OF ANY KIND WITH RESPECT TO IT. ADI SPECIFICALLY DISCLAIMS ANY REPRESENTATIONS, ENDORSEMENTS, GUARANTEES, OR WARRANTIES, EXPRESS OR IMPLIED, RELATED 
TO THE EVALUATION BOARD INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY, TITLE, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF INTELLECTUAL 
PROPERTY RIGHTS. IN NO EVENT WILL ADI AND ITS LICENSORS BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES RESULTING FROM CUSTOMER’S POSSESSION OR USE OF 
THE EVALUATION BOARD, INCLUDING BUT NOT LIMITED TO LOST PROFITS, DELAY COSTS, LABOR COSTS OR LOSS OF GOODWILL. ADI’S TOTAL LIABILITY FROM ANY AND ALL CAUSES SHALL BE LIMITED TO THE 
AMOUNT OF ONE HUNDRED US DOLLARS ($100.00). EXPORT. Customer agrees that it will not directly or indirectly export the Evaluation Board to another country, and that it will comply with all applicable 
United States federal laws and regulations relating to exports. GOVERNING  LAW. This Agreement shall be governed by and construed in accordance with the substantive laws of the Commonwealth of 
Massachusetts (excluding conflict of law rules). Any legal action regarding this Agreement will be heard in the state or federal courts having jurisdiction in Suffolk County, Massachusetts, and Customer hereby 
submits to the personal jurisdiction and venue of such courts. The United Nations Convention on Contracts for the International Sale of Goods shall not apply to this Agreement and is expressly disclaimed. 
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